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Warning : NeAT can replace Microsoft Program Manager, but some installation programs 
will issue DDE calls to Windows Program Manager assuming it is present. Therefore, you 
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File menu commands
The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same 

file name.
Save As Saves an opened document to a specified file 

name.
Exit Exits NeAT v1.3.



Edit menu commands
The Edit menu offers the following commands:

Undo Reverse previous editing operation.
 Cut Deletes data from the document and moves it to the 

clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.



Groups menu command
The Groups menu offers the following commands:

New Create a new group.
Import Imports a Program Manager group.
Select Choose a set of programs and documents to open
Rename Change the name of the currently selected group
Reorder Modify the order of groups in the Groups list
Delete Remove the group currently selected and all its items
Startup group The group currently selected becomes the Startup 

Group, all the items in this group will be opened at 
startup time

Next Select the next group
Previous Select the previous group



Special menu command
The Special menu offers the following commands:

Used items List of recently used items
Run Open the program currently selected
Edit item Display command line, icon path, button name and 

startup directory
Execute Launch any file or document even if it is not 

associated with a button.
Choose font Select the font used to draw buttons
Preferences Set miscellaneous options



View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Information Display miscellaneous system 

information



Help menu commands
The Help menu offers the following commands, which provide you assistance with this 

application: 
Index Offers you an index to topics on which you can 

get help.
Using Help Provides general instructions on using help.
About Displays the version number of this application.



New command (File menu)
Use this command to create a new document in NeAT v1.3.    By default, each new 

document created by NeAT has one group called "New Group" and one item, the 
Microsoft Windows File Manager. You can open an existing document with the Open 
command.

Shortcuts
Toolbar:

Keys: CTRL+N



Open command (File menu)
Use this command to open an existing document in a new window. You can create new 

documents with the New command.
Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box
The following options allow you to specify which file to open:
File Name
Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
.LNC is the file extension for NeAT documents.
.GRP is the file extension for Program Manager groups.
.EXE, .COM are the file extensions for program files.
.BAT is the file extension for MS-DOS Batch files.
.PIF is the file extension for Program Information files.
.DLL is the file extension for Dynamic Link Library, some of them contain icons.

Drives
Select the drive in which NeAT v1.3 stores the file that you want to open. 

Directories
Select the directory in which NeAT v1.3 stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)
Use this command to close all windows containing the active document.    NeAT v1.3 

suggests that you save changes to your document before you close it. 
If you close a document without saving, you lose all changes made since the last time you

saved it.    Before closing an untitled document, NeAT v1.3 displays the Save As dialog 
box and suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as 
shown below:



Save command (File menu)
Use this command to save the active document to its current name and directory.    When 

you save a document for the first time, NeAT v1.3 displays the Save As dialog box so 
you can name your document.    If you want to change the name and directory of an 
existing document before you save it, choose the Save As command.

Shortcuts
Toolbar:

Keys: CTRL+S



Save As command (File menu)
Use this command to save and name the active document.    NeAT v1.3 displays the Save 

As dialog box so you can name your document. To save a document with its existing 
name and directory, use the Save command.

Alternate Shell
Toolbar:



File Save As dialog box
The following options allow you to specify the name and location of the file you're about to

save:
File Name
Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    NeAT v1.3 adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four 

documents you closed.    Choose the number that corresponds with the document you 
want to open.

Alternate Shell
Toolbar:



Exit command (File menu)
Use this command to end your NeAT v1.3 session.    You can also use the Close command 

on the application Control menu.    NeAT v1.3 prompts you to save documents with 
unsaved changes.

If NeAT is Windows Shell (see Preferences), then the label for the command is Exit 
Windows, it will close all opened application, prompting to save unsaved documents if 
necessary, and then shut down Windows returning to DOS.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4
Alternate Shell

Toolbar:



Undo/Can't Undo command (Edit menu)
Use this command to reverse the last editing action, if possible.      The name of the 

command changes, depending on what the last action was.    The Undo command 
changes to Can't Undo on the menu if you cannot reverse your last action.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)
Use this command to remove the currently selected data from the document and put it on 

the clipboard.    This command is unavailable if there is no data currently selected.
Cutting data to the clipboard replaces the contents previously stored there.
Shortcuts

Keys: CTRL+X



Copy command (Edit menu)
Use this command to copy selected data onto the clipboard.    This command is 

unavailable if there is no data currently selected.
Copying data to the clipboard replaces the contents previously stored there.
Shortcuts

Keys: CTRL+C



Paste command (Edit menu)
Use this command to insert a copy of the clipboard contents at the insertion point.    This 

command is unavailable if the clipboard is empty.
Shortcuts

Keys: CTRL+V



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the 

most common commands in NeAT v1.3, such as File Open.    A check mark appears next
to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    
The toolbar provides quick mouse access to many tools used in NeAT v1.3,

For help regarding the toolbars in the alternative shell, please see Advanced Interface.

 TIP !
To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). In the 
advanced interface, double click the title bar to display the View menu.

Click To
Open a new document.

Open an existing document.    NeAT v1.3 displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, NeAT v1.3 displays the Save As dialog box.

Display the Choose Font dialog box.

Select a group of programs or documents to display.

Add the Group name in the edit field of the Group list to the list.



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be 

executed by the selected menu item or depressed toolbar button, and keyboard latch 
state. A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the NeAT v1.3 window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

 TIP !
The left area of the status bar describes actions of menu items as you use the arrow 
keys to navigate through menus.    This area similarly shows messages that describe 
the actions of toolbar buttons as you depress them, before releasing them.    If after 
viewing the description of the toolbar button command you wish not to execute the 
command, then release the mouse button while the pointer is off the toolbar button.

The second box, starting from the left, displays the current time using 24:00 hours format.
In the advanced interface, the clock box is located at the bottom of the side toolbar.

The right areas of the status bar indicate which of the following keys are latched down:
In the alternative shell, the indicators area was removed to leave reasonable room for the 

information area. 
Indicator Description

CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you 

can jump to step-by-step instructions for using NeAT v1.3 and various types of 
reference information.    

Once you open Help, you can click the Contents button whenever you want to return to 
the opening screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of 

NeAT.
This program is a freeware, you dont have to pay for it, you cannot be charged for it 

(except for reasonable media cost).
Should you have comments and/or suggestions, please contact Pierre-Eric COLIN on :
CompuServe 100121,2155
E-Mail    (Internet) 100121,2155@compuserve.

com

Alternate Shell
Toolbar:



Context Help command 

Use the Context Help command to obtain help on some portion of NeAT v1.3.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and question mark.    Then click somewhere in the NeAT v1.3 window, such as another 
Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1

Alternate Shell
Toolbar:



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.
To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.
A title bar may contain the following elements:

Application Control-menu button
Document Control-menu button
Minimize button
Name of the application

Name of the document

Alternate Shell
Mouse: Double click the title bar to display the View bars menu. This menu lets you 

choose to show or hide the toolbars. see Displaying Toolbars.



Scroll bars
Displayed at the right and bottom edges of the document window.    The scroll boxes inside

the scroll bars indicate your vertical and horizontal location in the document.    You can 
use the mouse to scroll to other parts of the document.



Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with 

the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.
Note:    This command is unavailable if you maximize the window.
Shortcut

Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or 

dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.
Shortcut

Keys: CTRL+F7



Minimize command (application Control menu)
Use this command to reduce the NeAT v1.3 window to an icon.
Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space. This command 

is not available in NeAT.
Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)
Use this command to close the active window or dialog box.
Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on 
the document Control menu closes only one window at a time.    You can close all 
windows at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the NeAT window or a dialog box



Restore command (Control menu)
Use this command to return the active window to its size and position before you chose 

the Maximize or Minimize command.



Switch to command (application Control menu)
Use this command to display a list of all open applications.    Use this "Task List" to switch 

to or close an application on the list.
Shortcut

Keys: CTRL+ESC
Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with 
the following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box
This dialog is used to define the display of the buttons names such as Font, Style, Size, 

Attributes, Color.
The Sample box reflects the changes you have made. If you want to continue with the 

changes, choose OK. If you prefer to close the dialog window and leave the display 
unchanged, click the Cancel button.



No Help Available
No help is available for this area of the window.



No Help Available
No help is available for this message box.



NeAT button

Each program or document is associated with a button. When a button is selected the arrow 
on the right side is painted in dark gray. Associating buttons with programs or documents is 
easy, it can be achieved either by Drag and Drop, or by editing the item. see Add.

The first button is the one on the top left, the second is under the first, and so on. Ten 
keyboard shortcuts are defined, from 1 to 0. Please note that the shortcut keys are the keys 
located on top of your keyboard, not the numeric keypad keys.

 TIP !
A single click in a button launches the program or document. Each button can be 
customized to display a different name, icon, and so on (see Edit item). To display the
Edit dialog, hold the CTRL key while clicking the button.

Buttons can be reordered using right mouse button. see Drag and Drop.
You can decide whether or not the item icon will be displayed left to its name. see 

Preferences.
Drag and Drop and "Open" ... "Using" ... features
NeAT is a Drag & Drop client. You can drag items from a Drag & Drop server program 

(such as File Manager) and then drop (release the mouse button) the file on a NeAT 
button, it will generate an action. What will happen exactly depends on the context. see
Drag and Drop.

 TIP !
If you drop this file upon a button associated with a program (file name contains
.EXE) NeAT will try to Open the document dropped Using the program.

Shortcuts
Keys: left button click Launch application

ENTER Launch application
ALT+1, 2, ..., 0 Launch application
CTRL + left button click Open Edit item dialog
CTRL + ENTER Open Edit item dialog
F2 Select first button in first column
TAB Select first button of the next column
DOWN ARROW Select next button in the column
RIGHT ARROW Select button in the next column
UP ARROW Select previous button in the column
LEFT ARROW Select button in the previous column



Group list

NeAT provides you with a quick launch interface to a set of application. Each set holds 15 
programs or documents, displayed in Buttons. The name for a such set is a Group. Use 
the list located in the Toolbar, to choose one of the groups. Once a group is selected, 
NeAT displays the programs and documents associated with it. Choosing from this list 
has the same effect as selecting the Choose Group command, but it is quicker.

 TIP !
You can change the appearance of the group list by inserting the following entry 
(using any text editor such as notepad.exe) in the General section of the NeAT.INI 
file:
BoldComboBox = 0
To revert to default, either remove the line above, or change it to:
BoldComboBox = 1

Shortcuts

Toolbar:
Keys: F3 Select the Group list

First letters + DOWNARROWSelect a Group
ALT + DOWNARROW Display the group list
F4 Show/Hide the group list



Used items sub menu (Special menu)
NeAT maintains a list of the 15 most recently opened programs or documents. These 

commands are available only if programs were previously launched.
Choose any of these menu items to re-open the program or document. The label of the 

menu is the same as the label of the button.
Alternate Shell

Toolbar:



Used items sub menu (Special menu)
The "not yet defined" greyed item means that no program or document has been 

launched yet by NeAT, and the standard Used items sub menu is not available.



Run command (Special menu)
This command is used to launch (execute) the currently selected NeAT item. The NeAT 

button selected is the one with a dark grey arrow on the right side. This menu 
command is active only if there is an item selected.

Shortcuts
Keys: RETURN
Mouse: Single left button click on the item



Edit item command (Special menu)
This command will bring up an Edit item properties dialog.
Shortcuts

Keys: CTRL + RETURN
Mouse: CTRL + Single left button click on the item



Choose font command (Special menu)
Select this command to bring up a Choose Font dialog box. 
This dialog is used to select the font and miscellaneous font attributes used to display the 

name of the programs and documents in NeAT buttons.
Alternate Shell

Toolbar:



Preferences command (Special menu)
This command will bring up a Preferences dialog box. Use this dialog to select 

miscellaneous program options.
Shortcuts

Keys: CTRL+P
Alternate Shell

Toolbar:



Rename command (Groups menu)
This command brings up a Rename group dialog box to modify the name of the group 

currently selected.
Alternate Shell

Toolbar:



Select command (Groups menu)
This command is an alternative to using the group list in the toolbar. It brings up a Select 

group dialog box.



Reorder command (Groups menu)
This command brings up a Reorder groups dialog box. You can use it to modify the order of

appearance of the groups in the list. This command is not available if there is less than 
two groups in the list.

Alternate Shell
Toolbar:



Delete command (Groups menu)
This command delete the group currently selected. All the items included in the group are 

deleted as well. Use this command when you want to get rid of a group that is not used 
anymore.

Alternate Shell
Toolbar:



Next command (Groups menu)
Select the next group in the list (see Select group). This command is not available if the 

current group is the last group in the list.
Shortcuts

Keys: CTRL + D
PAGE DOWN
DOWN ARROW (if the group list has the input focus)

Alternate Shell
Toolbar:



Previous command (Groups menu)
Select the next group in the list (see Select group) This command is not available if the 

current group is the first group in the list.
Shortcuts

Keys: CTRL + U
PAGE UP
UP ARROW (if the group list has the input focus)

Alternate Shell
Toolbar:



Add group
This command is available only if the edit field of the Group list holds a new group name. 

In other words, two groups cannot have the same name. If the maximum number of 
groups has been reached, this command is unavailable.

You can also import an existing Program Manager group file.
Clicking this button will add the group name defined in the edit field to the group list, in 

the last position. If you wish to change this position, you should use the Reorder 
command.

Each NeAT file can hold up to 64 groups, each Group shells 15 programs or documents, 
this is 960 program or document entries per file (the number of files you can use is 
unlimited).

A group name is any character combination. It can include 45 letters, symbols, numbers, 
spaces. 

Examples of valid group names:
Microsoft Windows 3.1
1,2,3...
Credits & Loans
$/£ Conversions
1. 1994 Reporting
2. 1994 Reporting



Edit NeAT item
This dialog box holds all the information necessary to display and launch the program or 

document.

Short name
This is the name displayed in the button, at the right of the icon. You can put any 
meaningful string of characters here. The length of the name should be less than 30 
signs, due to space considerations.

Hot key
Use this field to enter a hot key associated with the program, this hot key will be used to 
launch the document/program, but also to bring this application to top of the Windows 
desktop. See Hot Key.

Command line
This is the command used to launch the program or document itself. Normally, you should
not modify it, except to add optional parameters or flags, or to force a document open by 
a special application. 
Some program can receive and understand additional parameters. These additional 
parameters are different from a document name. They can tell a program whether it 
should start with a new document or not, and so on. All these options are changing from 
one program to the other. You should refer to the program documentation regarding the 
use of these parameters.
For example, under Windows, EXCEL.EXE /M will open the famous spreadsheet with a new
Macro document instead of a new spreadsheet.
You can also happend a document name after an application name, to force this 
document open by this application.
Under normal circumstances, this field should just contain the document name, at launch 
time, the application registered to this type of document will open it, but if you want to 
open the document with a different application, it is safe to use the above method.

Startup Directory
Change this entry if you want to assign a different startup directory.



Open file
Normal Don't do anything special
Minimized As an icon at the bottom of the screen
Maximized The application launched occupies the whole screen 

Icon...
Click this button to open an Icon browser dialog box. Use this command to change the 
icon displayed on the left of the button with the short name (see above).

Browse...
This command will bring up a file open dialog box. Use it to choose the file that you want 
to associate with this button. this is an alternative to Drag and Drop. see Add.

Delete
This command will remove the item edited and close the dialog box.

Help
This command will bring this help document

Cancel
This command will close the dialog box without saving the changes made by the user.

OK
This command will save the changes made to the item currently edited and then close the
dialog box.



Reorder groups dialog box
The list on the left is the Source list, it holds the names and the current position of groups.

The list on the right is the Destination list. 

You can decide to insert the group chosen in the Source list Before or After (almost) any 
element of the Destination list. Some items in the Destination list will be dimmed 
(unavailable) this is because selecting one of these items would be a nonsense. 

Insert radio buttons
Before The group selected in the source list will be inserted 

before the group selected in the destination list.
After The group selected in the source list will be inserted 

after the group selected in the destination list.

Help
This command will bring this help document

Cancel
This command will close the dialog box without saving the changes made by the user.

Insert
This command will save the changes made to the groups ordering and then close the 
dialog box. This    command is available if there is a group selected in the Source list, and 
a new position selected in the Destination list. 



Preferences dialog box

Use this dialog to choose from the following options:

NeAT is always on top
Checked NeAT windows is always visible even though it is not 

currently active.
Unchecked NeAT windows behaves normally.

Minimize NeAT...
Checked After launching an item, NeAT turns itself to an icon at 

the bottom of the screen.
Unchecked NeAT windows is unchanged after launching an item.

Open the most recently...
Checked This is the default option. NeAT will automatically open

the last file used at startup time.
Unchecked NeAT will create a new empty document at startup 

time.

Select the first group
Checked When opening a file, NeAT will display the first group.
Unchecked When opening a file, NeAT will display the last group 

used.

Advanced Interface*
Checked Uses the advanced interface display
 Unchecked Uses standard display



*this command will be effective next time NeAT is opened

Show item Icon
Checked NeAT will draw the icon of the item on the left of its 

name.
Unchecked NeAT will only display the name of the item. Use this 

option to increase display speed.

Show item hot key ...
Checked NeAT will show the hot key combiantion for an item in 

the status bar when the mouse cursor is above the 
item.

Unchecked NeAT will not modify the standard behaviour of the 
status bar.

NeAT is Windows shell*
Checked Inserts the following line in Windows system.ini file:

Shell=....\...\NeAT.EXE
(where ...\... is the path to NeAT.EXE)

Unchecked Replaces the command above by:
Shell=Progman.exe

*this command will be effective next time Microsoft Windows is opened

Confirm Windows exit
Checked This is the default option. When NeAT is Windows shell,

at exit time, there is a message prompting the user to 
confirm the exit command.

Unchecked When NeAT is Windows shell, does not prompt the user
before exiting. Prompts related to modified 
documents, either in NeAT or in other applications, still
apply.

Aliases are always visible
Checked This is the default option. When NeAT is minimized, 

aliases are still visible.
Unchecked When NeAT minimized, aliases are hidden.

Aliases are always on top
Checked Alias windows are on top of any other window even if 

they are not active.
Unchecked Alias windows are covered by other applications 

windows when NeAT is    not active.

NeAT Hot Key
Enter here the key combination you wish to use for the Hot Key feature.
Any combination of CTRL, ALT and SHIFT (but not SHIFT by itself) plus any character is 
allowed. See Hot Key feature for more details.



Help
This command will bring this help document

Cancel
This command will close the dialog box without saving the changes made by the user.

OK
This command will save the changes made and then close the dialog box.



Choose Icon dialog box

Each program or document can have its own icon. By default, a program is installed with its 
standard icon, and a document is installed with the icon of its parent application. If this icon 
is unavailable for some reason, then a default icon is used.

Default icon:  

Icon file path
This text box holds the name of the file containing the icon you wish to use. You can 
either type in the pathname to the file containing the icon, or use the Browse command 
(see bellow).

Icon list
You must select one of the icons displayed in this list for your application or program by 
clicking on it. If the list is empty, then the Icon file (see above) does not shell any icon, or 
the Icon file path is invalid.

Browse
This command will bring up a standard file Open dialog, so that you can find the file that 
contains the icon you wish to use with this program.

Help
This command will bring this help document

Cancel
This command will close the dialog box without saving the changes made by the user.

OK
This command will save the changes made and then close the dialog box.



Rename Group dialog box

This dialog is used to change the name of the group currently selected. It is active only if a 
group is selected.

Group name
This text field is used to type in the new group name. A group name must be less than 45 
characters.

Help
This command will bring this help document

Cancel
This command will close the dialog box without saving the changes made by the user.

OK
This command will save the new group name and then close the dialog box.



Choose Group dialog box

This dialog is used to select a group. It is equivalent to using the Group List in the toolbar.

Group list
In this list box, a list of every available group is displayed. You must select one of those 
names.

Help
This command will bring this help document

Cancel
This command will close the dialog box without saving the changes made by the user.

OK
This command will select the new group, display the group items and close the dialog 
box.



Add a program or document
Programs and documents are handled in exactly the same fashion. There is two methods 

to add programs or documents (or add items), the easy one and the ...other one! If you 
try to install an application or a program on a button already used, you will be able to 
cancel the operation.

The easy method: 
Drag the desired file from the Windows File Manager (or any other Drag and Drop server 

application), and drop it above the button that you want to associate with it. If this 
button already shells a program, hold the CTRL key to replace this program by the new 
one. see Drag and Drop.

You can drag several items at the same time. How many can be dragged depends on 
where the files are dropped. The rule is that the dropped files fill the buttons, starting 
with the one they were dropped in, ending at the end of the Group. Buttons could be 
numbered from 1 to 15, starting top left with #1, the one bellow #2 and so on. If you 
drop the files on button #10, then you can drop 6 files (#10 to #15). So the maximum 
number will be 15, dropped on the first button, and the minimum will be 1 if dropped on
the last button.

The ...other... method: 
This method can be useful in one situation: When NeAT is Windows shell (started as a 

replacement to the program manager), and when no Drag and Drop server is available. 
In that case, you should edit Buttons and type the file path and name.



System Information dialog box

This dialog shows several useful information regarding free memory, resources, program 
versions and computer type.



Information command (View menu)
This command will bring up a System Information dialog box.
Alternate Shell

Toolbar:



Import command (Groups menu)
NeAT is capable of reading the Program Manager .GRP files and to convert them into NeAT 

groups. It is a fast means to create groups already defined with Windows Program 
Manager.

This command brings up a standard file Open dialog, you must pick a .GRP file (usually in 
the Windows directory). The newly created group is the last group of the list.

If there is more items in the file than NeAT can import in a group, NeAT will create several 
groups. Each group will have the three last letters of its name set to .XX, where XX 
stand for a number.

Alternate Shell
Toolbar:



Group name error dialog box

This dialog indicates that the group name you gave (or the one defined in the .GRP file) 
already exists. Group names must be unique. You must type in a new name.

New name
This text field is used to type in the new group name. A group name must be less than 45 
characters. Make sure to type a unique name.

Help
This command will bring this help document

Cancel
This command will close the dialog box and cancel the operation in progress (usually 
a .GRP file import).

OK
This command will rename the new group with the name typed and close the dialog box.



Startup group command (Groups menu)
A startup group is a group whose items are automatically opened at Windows startup 

time. This group can hold up to 15 elements. Each element is opened according to the 
options defined in the item properties dialog (see Edit item).

A startup group is optional, that is, you may choose to have one, or none.
A check mark before the Startup group indicates that the group currently selected is the

startup group.
To indicate that the group currently selected should become the startup group, then select

the unchecked Startup group command.

 TIP !
To cancel the current startup group selection, either choose a new startup group (see 
above), or just select the checked Startup group command, it will toggle the 
selection status and the startup group feature will be disabled until you choose 
another valid startup group.

Alternate Shell
Toolbar:



Advanced interface
NeAT v1.3 lets you choose an alternate display mode, known as Advanced interface. This 

mode can be toggled on or off in the preferences dialog.
This shell proposes icons for the most frequently used commands under NeAT, and no 

menu bar. The accelerator keys are the same as using regular display.



Hot Key Feature
NeAT v1.3 implements several Hot Key features. 
What is a Hot Key
The hot key is any combination of CTRL, ALT or SHIFT (but not SHIFT by itself) plus any 

key. This includes special keys such as HOME, numeric keypad and so on. Make sure 
that you test the behaviour of the combination choosen, because some hot keys are 
not permited by Windows or used by applications.

Bring NeAT to front
By pressing a key combination defined by the user, the NeAT window will be automatically

brought to front, no matter in which application the user was when the hot key was 
pressed.

This hot key can be defined in the Preferences dialog.
Application Hot Key
In addition, every program or document can have its own hot key. It can be defined using 

the Edit item dialog. Each hot key must be unique.
Application Launcher:
If NeAT is the active application, then, pressing a hot key will launch the application or 
document, just like clicking the button, even though the currently selected group is not 
the application group.
Application retreiver:
If NeAT is not the active application, and the application has been previously launched, 
then pressing the hot key will bring this application on top of all others. If you launch 
several times the same application, only the most recently opened will be called by the 
Hot Key.
This feature is not guaranteed to work because some applications do not fully respect 
Microsoft specifications. 



Installation
The session files, created by NeAT use the following extension : .LNC
In the program directory, you should find the following files:
NeAT.EXE The program file.
NeAT.HLP The program help file - The file that you are currently 

consulting.
NeATCvrt.EXE NeAT File Converter program file.
README.WRI Last minute information and comments that couldn't 

be included in this help file.
In the Windows directory, you will also find the file named:
NeAT.INI The program initialization data.
In the System subdirectory of the Windows directory, you will also find the file named:
NeATHook.DLL A dynamic link library holding some NeAT functions.
CTL3DV2.DLL Dynamic Link Library used for 3D effects.



Displaying Toolbars
In the normal interface configuration, use the View menu.

 TIP !
In the advanced interface configuration, it is possible to Show or Hide each toolbar 
independently. To display a popup menu that lets you choose these options, just 
double click in the window title bar using the left mouse button.



Execute command (Special menu)
This command will bring up a file open dialog box. Choose any file that you want NeAT to 

open.
You can also type the path and name of the file in the filename edit field.
You cannot add additional parameters (also known as command line arguments), if you 

wish to use these arguments, please associate the program or document with a button.

 TIP !
Holding the CTRL key while activating the Execute command will bring up a Find 
dialog box.

Alternate Shell
Toolbar:



NeAT Button Drag and Drop
There is a distinction between Windows Drag & Drop (dragging a file from the File 

Manager to a program for example) and NeAT Button Drag and Drop. The Windows 
Drag & Drop is a feature standardized among almost every Windows application.

NeAT is a Windows Drag & Drop client. It means that you can transfer information 
between the File Manager and NeAT by dragging a file from the File Manager and 
dropping it above NeAT.

 If you drop this file upon a button associated with a program (file 
name contains .EXE) NeAT will try to display the document dropped using the program.

If the button is not associated, or it is associated with a document file, 
or if you hold the CTRL key while dropping on a button associated with a program, NeAT will 
associate this button with this file. see Add.

If you drop a file into the NeAT window, but outside the buttons area, 
NeAT will try to open this file as a NeAT document file. see Open.

NeAT is a Private Drag & Drop server. It means that you can transfer information 
between NeAT and other applications aware of the NeAT Button Drag and Drop 
protocol.

As a self client, the position of buttons can be easily changed. Just click on the NeAT item 
with the right mouse button. Hold the mouse button pressed, and drag the NeAT item 
to the new position. The NeAT button will be installed in this new position, while in turn, 
the target item will be assigned the previous position of the dragged item.

This cursor means releasing the right mouse button has no effect.
This cursor means that the window under the cursor is aware of of the NeAT Button 

Drag and Drop protocol, and releasing the right mouse button will generate some action. In 
the case of NeAT, it will put the dragged NeAT item in place of the NeAT item bellow.

 TIP !
The Drag and Drop feature can be used to copy a NeAT button from a NeAT file to 
another. You must launch NeAT twice, in one instance of NeAT open the file holding 
the buttons that you want to copy, in the second instance of NeAT, open the file you 
want to copy the NeAT buttons to. Arrange the NeAT Windows on the screen so that 
they dont overlap, and then, Drag from the source NeAT application to the 
destination NeAT application.
In a near future several applications will take advantage of this feature. 

 TIP !
Clicking the left or middle mouse button while dragging a NeAT item will cancel the 
dragging operation.



Users corner
They said:
Harald M. Deike, CompuServe 100022,2651

Dear Pierre-Eric, I have just downloaded version 1.2 of NeAT from CompuServe an 
hour ago. After only 15 minutes I got started with it and I'm asking myself how I could
have been working with the Windows Application Manager before? The screen looks 
much nicer (not so clumsy) and your product works flawlesly so far. It's a much better
shell than HP's Dashboard or the Norton Desktop (YUKKK). 

Reginald P. Chang, CompuServe 75250,1131
Pierre-Eric, I downloaded your program, NeAT 1.2, and have enjoyed it very much so 
far. (...) Thanks for a great Freeware product that is worth using. 

Nat Johnson, CompuServe 73707,1166
First, congratulations on a terrific interface -- very close to what I've been looking for. 
(...)    Thanks for a great interface. Please let me know when you've uploaded an 
upgrade! -

Steven Justice, CompuServe 72644,2643, University of California, Berkeley
Pierre-Eric-- Thanks for such an elegant and resource-saving launcher. I've tried 
literally dozens of shells, commercial, shareware, and freeware, and this is one of my 
two or three favorites. You could certainly charge money for this if you wanted to. 
Again, thanks for a fine product.

Ken, CompuServe CompuServe 73534,1576, Paragon Security
Thank you for submitting your Program Manager Software and for making this so 
readily    available. I really enjoy your ideas. (...) I'll be glad to see more versions of 
your programs as they are available.

Ruth Winfrey, CompuServe 74547,2135
I am sending you a thanks for your cool program. I would like to know if this program 
is on disk, I would be more than happy to send some money for your efforts and time 
spent (...)Your program is definitly worth asking for some compensation, after all time
is money, and money is time.

Dave W. Beauvais, CompuServe 72662,1403
I just downloaded NeAT today and love it.    I think it is much better than Program 
Manager.    There are very few PM replacements that I can say that about.



 NeAT File Converter
The format of NeAT files has been changed many times since NeAT    was created, mostly 

to implement new features. Each file format needs its own algorithm to load the 
information it shells. It is a lot of program code to include with NeAT, just to keep 
compatibility with the previous versions, while any application must be as small as 
possible. 

This is why a special utility program called NeAT File Converter was made. Each version of 
NeAT will ship with its associated file converter. The role of the file converter is to take 
any NeAT file from a previous version, and convert it to a file that the current version of 
NeAT can use. In case of version incompatibility, NeAT will now issue a warning 
message, advising the user to use the File Converter.

The commands of the File Converter are very simple:
Open...
Use this command to load a NeAT file. The File Converter will display basic information 

about the file, including its content and current version number.
Convert
This command is active only when a NeAT file has been opened. Use this command to 

update the NeAT file in a format that the latest version can read. This command will 
overwrite the former file version.

Convert To...
This command is active only when a NeAT file has been opened. Use this command to 

create an updated copy the NeAT file in a format that the latest version can read. This 
command will not modify the opened file.



Aliases

An alias is a small window that you can drag anywhere on the screen. It is an alias to an 
existing NeAT button in a group. You cannot edit the properties of an alias, instead you 
should edit the parent button. If the parent button is deleted or modified, the alias is 
destroyed or changed accordingly.
An alias can be visible when NeAT is minimized, it can also be on top of all other windows 
(see Preferences). The primary use of an alias is to always have at hand your most 
frequently used NeAT buttons. Aliases also support Windows Drag and Drop, if you drag a file
from the Windows File Manager above an alias window and then release the mouse button, 
NeAT will try to open the dropped file with the application in the alias.

Aliases can be reconfigured by right mouse button drag and drop. In other words, to 
assign a different button to the alias window, just drag and drop any other NeAT button.

There is two methods to create an alias. First you must select the group in which the 
button you want to give an alias to is located. Then, either click this NeAT button with 
the left mouse button, while holding the shift key, or click this NeAT button with the 
middle mouse button.

To move an alias window, use the tiny caption bar above the NeAT button.
To close an alias window, either click in the tiny close box on top left, or press Alt+F4.
Even though the number of alias windows you can use is only limited by the available 

memory, you should only use a reasonable number of them    to avoid slowing down the
system.



Find command

To display a find dialog, hold the CTRL key while either clicking the  button or while 
selecting the Execute... command in the Special menu.



Find dialog box

This dialog is used to search the currently opened .LNC file to retreive one or more items.

Find what
Enter in this edit field the character string to look for. This string is called search pattern.

Explore
The explore group of check boxes defines which components of the NeAT buttons will be 
explored during the search. The more components are checked, the more complete the 
search will be, the slower too. At least one component must be checked to allow a proper 
find.
Short name : if this component is checked, NeAT Buttons containing the search pattern in 
their title will be retreived.
File pathname : if this component is checked, NeAT Buttons containing the search pattern 
in their command line will be retreived.
Startup Directory : if this component is checked, NeAT Buttons containing the search 
pattern in their startup directory line will be retreived.
Icon file pathname : if this component is checked, NeAT Buttons containing the search 
pattern in their icon file pathname line will be retreived.

Search
Use this series of buttons to define how the NeAT file should be searched:
From home : from the first item in the file, to the last item.
Down : from the currently selected (focused) item in the file, to the last item.
Up : from the currently selected (focused) item in the file, to the first item.

Find
This command will start searching the search pattern in the opened file, the results will be
displayed in the list on the lower part of the dialog box.



Select
This command is active only when a NeAT button    is selected in the list. It will select the 
NeAT group containing the item selected in the list.

Run
This command is active only when a NeAT button    is selected in the list. It will launch the 
NeAT item selected in the list.

Cancel
This command will close the dialog box.

Help
This command will bring this help document






